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User manual for software for  

wood thermal treatment according to ISPM 15 
 

1. Description 

1.1. Wood thermal treatment 

This application is used for the verification process of thermic treatment of wood (sterilization). The 

application runs on PCs with Windows XP or later. The application collects data from measuring devices 

MKS-08 or MKS-16 through the RS485 communication line. The collected data on temperatures in 

chambers are entered into the database. After completing the process of collecting data, on request, the 

application generates a report in the form of a diagram. 

Block scheme of connecting the system to thermic treatment (as represented by the ability to 16 chambers): 

 
 

Data is stored in a MS Access database. Database is protected from unauthorized use, but in order to 

achieve full control of access to the computer and data, it's necessary to configure access rights at the 

operating system level. 

 

 

2. Requirements 

PC should have a COM (serial) port or USB port. Depending on the port that is used, order appropriate 

adapter for communication. 

PC should have installed the operating system (Windows). 

It is recommended (and optional) that PC has color printer for graphic displaying of temperatures of certain 

treatments. 

It is recommended (and optional) that PC has an uninterrupted power supply (UPS). 

Administrator of the PC should provide backup (archiving, making safe copy) of database which will be 

stored in PC for restoring data in the cases of system breakdown or database corruption. 
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3. Instalation 

3.1. Instalation from CD 

After inserting CD in driver on your PC, Autorun should start and open this page in your default web 

browser. Click on link below to start installation. 

Installation program is at Install\Install WTTreatment.exe 

Starting installation starts procedure that should be followed and finish. 

 

3.2. Instalation from Internet 

Installation program can also be downloaded from this internet link Download. After downloading, startup 

installation do install updated version of NIGOS Manager. 

 

3.3. Drivers for USB-RS485 adapter 

If you are using a USB adapter for communication, and Windows can not find it, on the disc is the 

installation of the drivers. 

After connecting USB adapter, Windows asks for drivers, it is necessary to specify the path to the CD 

folder USB driver. 

Drivers are downloaded from http://www.ftdichip.com/Drivers/D2XX.htm 

Original instructions for installing drivers 

4. Starting software 

After the installation, the shortcut of application is created in Start menu: 

 

Click on WTTreatment icon starts program. 

file:///e:/Install/Install%20WTTreatment.exe
http://www.nigos.rs/Applications/Sterilizacija/Install%20WTTreatment.exe
file://///BOJAN/Work/Temperatura/MKS/Tehuput/USB%20driver
http://www.ftdichip.com/Drivers/D2XX.htm
http://www.ftdichip.com/Support/Documents/InstallGuides.htm
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If there are defined users, after starting application, login dialog box pops-up for entering username and 

password. 

 

If a wrong user name or password is entered, the application notifies user of the error and asks for re-entry. 

 

    or      

After 3 unsuccessful attempts the application shuts down and all have to start from scratch. 

 

 

5. Basic menu 

On main window is the menu display and several quickstart buttons. 

 

 

In File menu are open reports and program exit. 

In Config menu are program preferences. 

In Windows menu are settings for windows. 

In Help menu are help descriptions and info about program. 

 

file:///D:/Work/_Temperatura/MKS/Tehuput/Help%20files/Espanol/Osnovni%20meni.htm
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6. File 

There is Report and Exit item. 

 

Report - view reports of sterilization 

Exit - exit the program 

 

6.1. Report 

To generate report, user can choose Reports from File menu of program or by pressing keys Ctrl + I. After 

that new windows will be open list of all available reports, sorted by closing time. 

 

Columns presented in Table are: 

· Process ID (unique number automatic added at process start), 

· Validation check (YES or NO means if sterilization requirement are fulfilled or not), 

· Chamber (name of chamber in which process is happening), 

· Process ending time , 

· Info about materials. 

Choose Open to select process (selection is made by clicking on chosen row in table, and indication of 

selected row is black arrow in one of rows on the left side of table). After that, new dialog will be open 

with options for report generation. 

file:///D:/Work/_Temperatura/MKS/Tehuput/Help%20files/Espanol/File.htm
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In this dialog, user can define time span of report (time span often should be short cause better resolution 

of diagram for period user is interested in). 

After that, user can define the temperature span that would be presented on diagram, and finally names and 

colors which would represent individual temperatures in generated diagram. 

Option "Treatment period only" only show time span of process when conditions are satisfied (sometimes 

this option is not available).  

After selecting the desired parameters, user can print Graphic or Spreadsheet reports. 
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6.2. Graphic report 

 
 



 

 

EQUIPMENT FOR MEASUREMENT&CONTROL AND DRYERS 
B. Nikolica-Serjoze 12, 18000 Nis, Serbia; Phone/Fax:+38118 211-212, 217-468; office@nigos.rs; www.nigos.rs  
  

 Software for wood thermal treatment according to ISPM 15 (versión 1.1) 7 

6.3.  Spreadsheet report 

 

At the top of the window are Print preview buttons. 
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6.4. Preview 

In the preview window, there is toolbar that used to see all pages reports, set printer and print the report. 

Also, the reports can be recorded in a file and user can later open them and print. 

 

 

6.5. Exit 

On leaving program, user need to confirm leaving. 

 

 

 

 

7. Configuration 

The Setup menu contains the items for setting various options of. 

 

Communication - communications parameters setup 

Company - basic data on sterilization company setup 

Chambers - basic data on sterilization chambers setup 

Users - program access rights setup 

Language - language choose 
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7.1. Communication parameters 

In this windows user setup communication parameters. 

 

If only single NIGOS's device is connected to the selected serial port, user have to select serial port and 

select the COM port. 

If there are more NIGOS's devices connected on the same serial port, then communication takes place via 

the communication server. In this case user should choose option to set the TCP port and IP address and 

port to which the communication server is started on. 

Communication speed should be set in every option. 

 

7.2. Company 

Setting up basic information about the company 

 

In this window should be set up basic information about the company that performed wood thermal 

treatment. These are the name, address, country and registration number which is obtained from the 

relevant Ministry. 

file:///D:/Work/_Temperatura/MKS/Tehuput/Help%20files/Espanol/Firma.htm
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If you change any description, you must press the button  before closing the window. If you don't 

want to changes description, press . 

In the Logo window can load pictures to be displayed at the top report as a company logo. Double-click to 

the field thumbnails, opens a window for select a file on disk. 

 

7.3. Chambers 

In this window user should enter info about installed sterilization chambers. 

  

Name can be a symbolic name of chamber in order to distinguish if there are any more. Address is the 

actual address or description of the physical location of the chamber. Registration number is as the one 

described in the company, if there is only one chamber, or registration numbers of every chamber and each 

has its own registration number. 

In Device type, choose the type of measure boxes that read temperatures. In Communication address enter 

the address of measure box. 

NOTE: If you have more measure boxes on the same communication line, two measuring boxes can not 

have the same communication address. 

By button  user choose chamber which he want to change data.. 

By button  new chamber can be added.. 

By buttons  and  user update or cancel changes in database.. 

By button  preview of database is updated. 

 

file:///D:/Work/_Temperatura/MKS/Tehuput/Help%20files/Espanol/Komore.htm
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7.4. Users 

Here user can add users who can work with this program and their rights or change user information or add 

new users. 

 

Buttons at bottom of window are for moving through user list, adding users and entry into database. 

A user who has administrator rights can change the configuration program, but normal user can not change 

the configuration program. It means Setup menu is banned for users. 

 

7.5. Language 

Depending on how the strings defined in the description, by this option user can choose which descriptions 

would be occur. 

 

 

 

 

 

file:///D:/Work/_Temperatura/MKS/Tehuput/Help%20files/Espanol/Operateri.htm
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8. Windows 

These items customize windows displaying in main window if there are more. 

 

Item name describes the way of windows sorting. 

 

9. Help 

The menu contains two menu items, Contents and About. 

 

Option Content opens this help file. 

Option About.. open informations about programu and author.. 

 

 

 

file:///D:/Work/_Temperatura/MKS/Tehuput/Help%20files/Espanol/Pomoc.htm


 

 

EQUIPMENT FOR MEASUREMENT&CONTROL AND DRYERS 
B. Nikolica-Serjoze 12, 18000 Nis, Serbia; Phone/Fax:+38118 211-212, 217-468; office@nigos.rs; www.nigos.rs  
  

 Software for wood thermal treatment according to ISPM 15 (versión 1.1) 13 

10. Show chambers 

 

Initially after installation, window Show Chamber launches the view of one chamber. Changing labels in 

Show Chamber window, title changes by the option Chamber Settings. More chambers can be added also. 

All controls in window support short message system for easier se of application. Just briefly hover mouse 

pointer over any control and tooltip will pop-up with suggestion, next to arrow or/and in statusbar at the 

bottom of window. 

In upper left corner of the window is an indicator that symbolizes measure devices and it shows measured 

temperature as same as are on measure devices. By that there are printed message on communication status 

and possible errors that occur in communications 
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In the case of system configuration with only MKS measure devices, there are shown only channel and 

measured temperature on that channel (red digits). If the case of configuration with NIGOS machines then 

there are additional black figures in upper left corner: temperature measured on the machine; and gray 

figures in upper right corner: desired device temperature. 

Also, right click on the indicator gets a context menu which includes items to display and define the status 

of the device and to define the status of measurement places, or probes.. 

 

Item OFFLINE(ONLINE) in the menu indicates current communication status with device. If after a 

certain number trials device does not respond to the application, status automatically switches to OFFLINE 

(device is disabled or faulty, communication line is interrupted, or similar). In this case, after removing the 

cause of interruption, using this menu item user may try to back ONLINE state.Item Active channels 

indicates that the probe is currently active and enabled; and enables user to activated or deactivated some 

probes. This should take care that all active probe must satisfy the criterion of minimum temperature of 

sterilization, and in this way should disable faulty probe or probes that are not able to meet criteria for any 

reason. Current regulations on thermic treatment of wood define at least 5 active probes - one probe for 

ambient temperature and 4 for temperatures inside wood. If during the process of activating or disable a 

probe, measuring time starts from the beginning. 

Button START is below indicators and it's for starting and stopping process (during process, name of 

button changes to STOP), and even below is control which gives information about the elapsed time from 

process starting or application starting, if execution of application was interrupted in the meantimes. 

 

In upper right corner is a group of controls that are used to define process. There are two controls for text 

input, for entering into the database data about amounts and type of the treated materials. It is allowed to 

enter a maximum of 50 characters and their contents are not strictly formatted, so each user can define the 

principle format that among his documentations. 
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Following from left to right, there are: control to define the end of data collectioning process, control for 

defining requirements for automatic ending of processes and controls to define frequency of updating 

database with collected data. 

After process starting, contents of these fields can not be changed. 

Application even in the cases of manual or automatic termination of process, analyzes conditions needed 

for verification of sterilization by a given criteria and when the conditions are met, prints message End of 

Process. 

 

In the bottom of window is the control which draws temperature diagram of the active probes. The left side 

is the diagram legend, user can there defines description of the probe, also is the appropriate probe visible 

or not and with which colour will be presented.  

It always draws a red line that represents the condition of sterilization (56°C) and if process use NIGOS 

measure devices it always draws black line and gray line for current and desired temperature. Right-click 

on the diagram brings you option to delete or print diagram. 

 

11. Calibration 

In some countries there is a requirement to perform 'calibration' or verification measurements. This 

operation ensure users that all probes are on the same temperature, near the operating temperature (50 ° - 

60 ° C). This can be provide by use of specialized calibrator or reference tools. For example, probe is 

placed in center of a hot water tank together with the reference thermometer probe. It is necessary to mix 

water with them and after about ten minutes the temperature of probes are stabilized. 

The application allows user to control this process. By pressing Start button, user opens calibration panel 

where he can adjust the temperature indicated by the reference thermometer. Button is in the lower right 

corner of the Chamber window, on statusbar. 

 

Statusbar displays the Chamber window and date of last calibration and the final minimum temperature of 

sterilisation. 

file:///D:/Work/_Temperatura/MKS/Tehuput/Help%20files/Espanol/Kalibracija.htm
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Then in application user should set the value of the temperature indicated by the reference thermometer 

and push button calibration. 

 

Based on the measured temperature of the probe, application determines a new minimum temperature of 

treatment. The new minimum temperature of treatment is changed for difference of maximum temperature 

of MKS device and the reference thermometer and the temperature is rounded to the first higher integer 

value. 

There are following limitations, all active probes must be connected and their display must be in the range 

± 5°C showing the reference thermometer. 

If user, after calibration, add one more probe and activate threatment, this calibration will no longer be 

valid. 


